BATCH PLOT
UTILITY AND
EXPRESS TOOLS
Chapter Objectives
After completing this chapter you should:
1. be able to use the Batch Plot Utility
to select and plot several drawings
unattended;
2. be able to specify which layers and
what drawing areas to plot with the
batch utility;
3. be able to install the Express Tools
from the AutoCAD 2000 CD-ROM,
load the Express menus, and invoke
the Express toolbars;
4. be able to use the Express
Text commands;
5. be able to use the Express
Layer commands;
6. be able to use the Express Standard
toolbar commands;
7. be able to use the Express Block
commands;
8. be able to use miscellaneous
Express commands from the pulldown menus and the command line.
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CONCEPTS
AutoCAD 2000 is shipped with many useful bonus tools and a batch plotting feature. The Batch Plot
Utility is installed automatically (if the Typical or Full installation is selected). The Express Tools are
installed only if you choose the Full option when you first install AutoCAD or use the Setup utility at a
later time and select the Express Tools for installation.
The Batch Plot Utility is very useful in an office or laboratory where many drawings must be printed or
plotted. This utility allows you to specify multiple drawings to be printed or plotted unattended. For
example, a set of drawings can be set up to be printed at night so they are ready for you when you return
in the morning.
Express Tools include several utility commands that have a specialized or streamlined usefulness. These
commands were not fully quality tested in time to make it in the documented AutoCAD 2000 command
set. However, many very powerful and useful features are available, including layer utilities and a
Layer Manager, text utilities, modify commands, draw commands, and miscellaneous tools.

BATCH PLOT UTILITY
AutoCAD 2000’s Batch Plot Utility is useful in offices or laboratories where many prints or plots are
made because a set of drawings can be assigned for plotting as a “batch” without human intervention.
For other applications, such as when a number of plots are required as a complete project set, the entire
set of drawings can be saved to a list to simplify plotting the same set again at a later time. Other specifications about the drawings to be plotted can be saved, such as which layers should be included in the
plot, drawing areas to plot, and the print/plot devices to use. A plot test can be used as a “dry run” to
locate any potential problems before running the batch. If errors occur during an unattended plot run,
an error log is kept so problems can be tracked.
The Batch Plot Utility requires AutoCAD for operation. Invoking the Batch Plot Utility in turn starts its
own dedicated AutoCAD session used just for plotting.
You can start the Batch Plot Utility by three methods:

Figure 47-1

1. Use the Windows Start Menu, choose Programs, then locate
and select Batch Plot Utility in the AutoCAD 2000 program
group.
2. Click the Batch Plot Utility shortcut icon in the AutoCAD 2000
program group (Fig. 47-1).
3. Use Windows Explorer to locate the BATCHPLT.EXE file in
the ACAD2000\SUPPORT\BATCHPLT folder.
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Once the Batch Plot Utility is started
(with its own AutoCAD session), the
AutoCAD Batch Plot Utility dialog box
appears (Fig. 47-2). Two pull-down
menus in this dialog box (File and
Options) allow you to specify which
drawings you want to plot and with
what parameters. The choices in each of
the pull-down menus are explained next.

Figure 47-2

File Menu
With this menu you manage the list of
drawings (or “batch” of drawings) you
want to plot. Drawings selected for plotting appear in the list displayed in the central area of the
AutoCAD Batch Plot Utility dialog box (see Figure 47-2).
Add Drawing…
Use this option to select drawings to include in the list. The Add Drawing File dialog box
appears (not shown) for you to locate and select the desired drawing(s).

Remove
Use this option to remove selected drawings from the list. First highlight the desired drawing
name(s) in the list, and then select Remove.

New List…
Use this menu item to clear the current list. This action is necessary in preparation for creating a new list
or selecting a saved list for plotting.
Open List…
Use this button to select a list of drawings (previously saved) to include in the list of drawings
to plot.

Save List…
When a group of drawings has been selected for plotting, you can save the list for future use
with this option. The file is saved as an ASCII file with a .BP3 file extension. The file also
records the options you select for plotting each drawing.
Append List…
This option appends (adds) a previously saved list (.BP3 file contents) to the current list of drawings to
plot. Using this method, several “sets” of drawings can be plotted in batch.
Plot
When you are ready to make the plots, select the Plot button. As AutoCAD progresses through
the plot batch, the current status for each drawing is indicated by a check mark placed just
before the drawing name (if the drawing is plotted correctly) or an “X” mark (if the drawing is
not plotted). Before plotting, select the options you want for each drawing using the options buttons or
Options pull-down menu.
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Plot Test

Figure 47-3

Selecting the Plot Test option causes
AutoCAD to make a “dry run” of
all the drawings listed for batch
plotting. In this test, each drawing is
checked to ensure all component parts are
located (Xrefs, linetypes, fonts, etc.) and to
ensure that the selected settings are operable.
Warning messages appear if a problem (or
potential problem) exists. For example, if an
attached Xref, raster file, font, etc., is missing,
AutoCAD reports it. A sample Plot Test
Results dialog box is displayed in Figure 47-3.
AutoCAD also creates a log file for each drawing in the batch for the plot test. These log files are automatically assigned a name beginning with the drawing name, followed by a set of numbers and a .LOG
file extension (such as ELEVATION_1_1_3805.LOG). Since each drawing is opened in AutoCAD for
batch plotting and for plot testing, the drawing log file gives the time the drawing was opened and other
activity that occurs such as resolving Xrefs. The sample log is shown below.
[ AutoCAD - Fri Jan 07 15:55:10 2000 ]————————————————————-------------------Opening an AutoCAD 2000 format file.
Resolve Xref “1st floor plan”: 1st floor plan.dwg
Resolve Xref “1st floor architectural”: 1st floor architectural.dwg
Resolve Xref “1st floor electrical”: 1st floor electrical.dwg
Resolve Xref “1st floor lighting”: 1st floor lighting.dwg
Regenerating layout.
Regenerating model.
[ AutoCAD - Fri Jan 07 15:55:16 2000 ]————————————————————-------------------AutoCAD menu utilities loaded.
AutoCAD Express Tools Menu loaded.
Command:
In Figure 47-3, a common warning is displayed. The message
“WARNING: xref file <path/filename.xlg> not accessible, xref
checking ignored” means that when Plot Test attempted to
check for missing Xrefs in the drawing, it could not create an
XLG file since XREFCTL was set to 0 in the drawing file. If the
drawing does not contain Xrefs, this message does not indicate
a problem.

Figure 47-4

Logging…
To locate problems that may have occurred during an
unattended batch plot, journal log file and error log
files could be checked. For example, if you set up a
batch of drawings to plot at night and an error occurred while
you were out, the log files would record if the drawings plotted
correctly or not. Two types of logs can be created while plotting: plot journals and error logs. First, you must select Enable
journal logging and Enable error logging in the Logging dialog box
(Fig. 47-4) before running the batch to plot.
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Enable journal logging
The plot journal is saved in the current folder (of the BATCHPLT.EXE file) under the name BPJOURNAL.LOG. This log keeps a list of all drawings that plot correctly during the batch plot session. The list
gives information about each plot such as the drawing location, selected tabs, page setup, plot device,
and time for each plot. An example plot journal is shown below.
1st floor.dwg, D:\ACAD2000\SAMPLE\, Model Tab, Default, HP LaserJet 4 Plus, 00:00:01
Elevation.dwg, D:\ACAD2000\SAMPLE\, *Current Tab*, Default, Default, 00:00:01
Enable error logging
When Enable error logging is checked in the Logging dialog box, a log is created listing the drawings that
did not plot during the batch plot session. An example plot journal is shown below.
ERROR: Failed to plot drawing: D:\ACAD2000\SAMPLE\Truck model.dwg
ERROR: Failed to plot drawing: D:\ACAD2000\SAMPLE\Watch.dwg
ERROR: Failed to plot drawing: D:\ACAD2000\SAMPLE\Campus.dwg

Options Menu
Your selections from this group of options determines how each drawing is plotted during the batch plot
session. To specify options for a particular drawing, first select the drawing from the list in the AutoCAD
Batch Plot dialog box (see Figure 47-2), then select the desired option(s) described below. Remember, an
entire set of options can be set for each drawing in the batch.

Figure 47-5

Layouts
The Layouts option produces the Layouts dialog box (Fig. 47-5).
Here you select the layouts contained in the drawing that you
want to plot. The Show all layouts button produces a list of the
named layouts contained in the drawing. Multiple layouts can be selected
by holding down the Shift key (to specify a range) or Ctrl key (to select
individual names) when you pick the layout names.

Page Setups
This option produces the Page Setups dialog box shown in
Figure 47-6 where you specify page setups to use during the
batch plot session. You can select from the page setups contained in the drawing or load other page setups from other drawings by
selecting the browse button in the lower-right corner.

Figure 47-6
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Plot Devices
This feature is especially powerful because you can
specify that different drawings in the batch plot session
be plotted with different devices. First, highlight the
desired drawing from the AutoCAD Batch Plot Utility dialog box
list (see Figure 47-2), then use the Plot Devices option to produce
the Plot Devices dialog box (Fig. 47-7). All AutoCAD-configured
devices for your system are available to choose from.

Plot Settings
The Plot Settings tab (Fig. 47-8) of the
Plot Settings dialog box
allows you to specify what
area of the selected drawing
you want to appear in the plot. You
can also specify the plot scale for the
selected drawing. Selecting Plot to file
does not create a paper plot but produces a .PLT file.

Layers
The Layers option also produces the Plot
Settings dialog box, but opens
the Layers tab. (This tab is not
available when several drawings are highlighted from the list in the
AutoCAD Batch Plot Utility dialog box.)
This tab allows you to indicate which
layers from the selected drawing should
be included in the plot (Fig. 47-9). The
selected drawing’s layer settings in the
Layer Properties Manager Plot column
are read and displayed as On or Off in
the Plotting On/Off column in this
dialog box.

Figure 47-7

Figure 47-8

Figure 47-9

Plot Stamping
Plot stamping, which was a feature in the AutoCAD Release 14’s Extended Batch Plot Utility, is not available in the AutoCAD 2000 Batch Plot Utility.
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EXPRESS TOOLS
Installing the Express Tools from the CD-ROM
To install the Express Tools when you install AutoCAD for the first time:
1. Insert the AutoCAD 2000 CD-ROM.

Figure 47-10

2. The Windows Setup utility should start automatically. If not, use Windows Explorer to find the
Setup.exe file on the CD-ROM. Double-click on
Setup.exe.
3. Proceed through the dialog boxes to accept the
license agreement, enter the serial number and CD
key, enter your personal information, and select the
destination location.
4. In the Setup Type dialog box, select Full (Fig. 47-10).

To install the Express Tools after AutoCAD is
installed on your system:

Figure 47-11

1. Insert the AutoCAD 2000 CD-ROM.
2. Use Windows Explorer to find the Setup.exe file
on the CD-ROM. Double-click on Setup.exe.
3. In the Setup Choices dialog box (Fig. 47-11), select
Add.
4. In the Custom Components dialog box (Fig. 47-12),
select Express Tools.

Figure 47-12

Installing the Express Menu and Toolbars
You may have to install the EXPRESS menu files if
you installed the Express Tools after you installed
AutoCAD. If the Express Tools were installed when
you first installed AutoCAD, you should not have to
perform this step. The Express Tools menu is located
in the ACAD2000\Express folder.
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To Load the Express Tools Menu
To load the Express Tools menu, use the Menuload
command (which is used to load a “partial menu”).
Menuload invokes the Menu Customization dialog box
(Fig. 47-13). In the Menu Groups tab, select the Browse…
button to locate ACETMAIN.MNU or .MNC. The Load
button loads the menu and “overlays” it on the
AutoCAD standard menu. Use the Menu Bar tab to
ensure the Express pull-down menu is installed.

Figure 47-13

Figure 47-14

To Load the Express Tools Toolbars
To bring the Express Menu toolbars onto the screen use the Toolbar
command to invoke the Toolbars dialog box (Fig. 47-14). At the
bottom of the box (in the Menu Group area), select EXPRESS, then
check each of the toolbars you want bring to the screen. Four toolbars are available: Express Standard Toolbar, Express Text Tools, Express
Block Tools, and Express Layer Tools.

Express Layer Tools Commands
Several useful layer utilities are available in this set. The productivity you can gain from these express commands is well worth the
trouble of loading these menus and toolbars. These commands
operate as an extension to the standard layer commands, allowing
you to accomplish in one command what might otherwise take two
or three commands or what might require multiple object or dialog
box selections.

LMAN
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Layers>
Layer Manager…

LMAN

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Lman is short for Layer Manager. Layer Manager allows you to save, restore, and edit layer settings. With
many drawings you may have certain combinations of layers that are frozen, thawed, on, or off for particular operations. For example, you may require a certain combination of layers to be On for making a
plot, while a different set of layers may be On for working with construction lines (Xlines, Rays) or for
creating dimensions and text. Instead of using the Layer command each time you make a plot and each
time you create and edit Xlines, dimensions, and text, you can Save these settings to be Restored at any
later time.
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Lman produces the Layer Manager: Save and Restore Layer
Settings dialog box (Fig. 47-15). The central area lists the
Saved Layer states (empty when you first begin). The
options operate as described here.

Figure 47-15

Save…
Using Save… invokes the Layer State Name dialog box (Fig. 47-16). Here
you can assign a name to the current layer settings. Normally, you would
want to specify the desired On, Off, Freeze, Thaw state for each layer before
using this option. However, once a layer state is created, you can use
Edit… to change the On, Off, Freeze, Thaw state of each layer. The layer
states are saved in the drawing file, so you can Restore the layer states
whenever needed. Spaces and other characters are allowed in the name.

Figure 47-16

Restore
Highlight a name from the list, then use this option to restore the selected Saved Layer state. AutoCAD
automatically sets the On, Off, Freeze, Thaw settings to those saved under the assigned name.
Edit…
This option allows you to change the layer settings for any named state. First, select the desired name
from the list, then press Edit.… The Layer tab of the Layer Properties Manager dialog box (not shown)
appears for you to make the desired changes.
Delete
This button deletes a highlighted saved layer state from the list.
Import…
You can import previously saved layer states from a file. Layer states are saved (with Export…) with a
.LAY file extension. Importing works well when you have several drawings with the same layer names
and functions (as when similar drawings are created from the same template drawing). Layer states can
be saved in one drawing, then Exported to a file and Imported to the other drawings.
Export…
Once you have created the desired layer states, you can save them to a file (with a .LAY extension). The
layer states can be imported into other drawings with Import.…
Options…
Selecting this button produces the Layer Manager: Restore Options dialog box (not shown). A new feature
in AutoCAD 2000, this dialog box gives additional power for using and restoring layer states. Normally,
when a layer state is restored, all the properties of the layers (when the layer state was created) are
restored. However, with this dialog box you can specify which properties of the layers are to be restored
when the layer state you select is made current. For example, you may have a layer state set specifically
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for displaying objects in different lineweights, but want to view the drawing with all lines having the
same lineweight. Simply restore the desired layer state leaving Lineweight status unchecked. The Options
feature is also especially helpful for creating new layer states similar to existing layer states by restoring
the layer state you want to “clone” but without restoring the properties you want to change.

LAYMCH
Pull-down Menu
Express
Layers>
Layer Match

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

LAYMCH

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Laymch allows you to change the layer of selected objects to the layer of the selected destination object.
This command performs the same function as the Matchprop command (see Chapter 12), but only with
respect to layers (Matchprop can change other properties such as color, linetype, or linetype scale).
Using Laymch produces the following prompt:
Command: laymch
Select objects to be changed:
Select objects: PICK
Select objects: PICK
Select objects: Enter
2 found.
Select object on destination layer or [Type-it]: PICK
2 objects changed to layer 0.
Command:

You can use the Type-it option to enter the name of the destination layer:
Select object on destination layer or [Type-it]: t
Enter layer name: text
2 objects changed to layer text.

LAYCUR
Pull-down Menu
Express
Layers>
Change to Current Layer

COMMAND
(TYPE)

LAYCUR

ALIAS
(TYPE)

Shortcut

…

…

Screen (side)
Menu

…

Laycur changes the layer of selected objects to the current layer. The following prompt is issued:
Command: laycur
Select objects to be changed to the current layer:
Select objects: PICK
Select objects: PICK
Select objects: Enter
2 found.
2 objects changed to layer TEXT (the current layer).
Command:
Copyright 1999 The McGraw-Hill Companies. All rights reserved.
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LAYISO
Pull-down Menu
Express
Layers>
Layer Isolate

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

LAYISO

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Use this express command if you want to turn Off all layers except the layer(s) of the selected object(s).
Several layers can be selected to be “isolated.” If more than one layer is isolated, the last one selected
becomes the current layer. The following prompt is used:
Command: layiso
Select object(s) on the layer(s) to be isolated:
Select objects: PICK
Select objects: PICK
Select objects: Enter
2 layers have been isolated. Layer TEXT is current.
Command:

LAYFRZ
Pull-down Menu
Express
Layers>
Layer Freeze

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

LAYFRZ

…

…

Screen (side)
Menu

…

Tablet
Menu

…

This utility Freezes the layer(s) of the selected object(s). More than one object (layer) can be selected for
Freezing with this command, but you select only one object at a time, then the prompt repeats. You
cannot Freeze the current layer. AutoCAD gives the following prompt:
Command: layfrz
Select an object on the layer to be frozen or [Options/Undo]: PICK
Layer TEXT has been frozen.
Select an object on the layer to be frozen or [Options/Undo]: PICK
Layer GEOMETRY has been frozen.
Select an object on the layer to be frozen or [Options/Undo]: Enter
Command:

You can use Undo to undo the last layer (object) selected. Type O for Options, which issues the following
prompt:
Select an object on the layer to be frozen or [Options/Undo]: o
Enter an option [Entity level nesting/No nesting]<Block level nesting>:

With the No Nesting option, only layers in the current drawing (not Xref layers or nested Block layers) are
Frozen. Entity level nesting and Block level nesting automatically Freeze Xrefs or Blocks down to the level of
the selected object (Block or Xref).
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LAYTHW
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Layers>
Thaw All Layers

LAYTHW

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Use this command to Thaw all layers in the drawing. Layers that are Frozen and Off are only Thawed by
this command so they still remain invisible until turned On:
Command: laythw
All layers have been thawed.
Command:

LAYOFF
Pull-down Menu
Express
Layers>
Layer Off

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

LAYOFF

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Layoff is used to turn Off the layer(s) of the selected object(s). Multiple objects can be selected (one at a
time) to turn off their layers. The Options are the same as those for Layfrz:
Command: layoff
Select an object on the layer to be frozen or [Options/Undo]: PICK
Layer ASESMP } 1-WALL has been turned off.
Select an object on the layer to be frozen or [Options/Undo]: Enter
Command:

LAYON
Pull-down Menu
Express
Layers>
Turn All Layers On

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

LAYON

…

…

Screen (side)
Menu

…

Tablet
Menu

…

This command is a quick way to turn all layers on. Layers that are Frozen are not affected; only layers
that are Off can be turned On with this command:
Command: layon
Warning: layer 0 is frozen. Will not display until thawed.
All layers have been turned on.
Command:
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LAYLCK
Pull-down Menu
Express
Layers>
Layer Lock

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

LAYLCK

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Laylck locks the layers of selected objects. There are no options for this command. If objects are selected that
are part of an Xref or Block, the layer that was current when the Xref or Block was Attached or Inserted is locked.
Command: laylck
Select an object on the layer to be locked: PICK
Layer TEXT has been locked.

LAYULK
Pull-down Menu
Express
Layers>
Layer Unlock

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

LAYULK

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Layulk has the opposite function of Laylck; that is, it unlocks the layers of selected objects. If the selected
objects are part of an Xref or Block, the layer that was current when the Xref or Block was Attached or
Inserted is unlocked. There are no options for this command.
Command: layulk
Select an object on the layer to be unlocked: PICK
Layer TEXT has been unlocked.
Command:

LAYMRG
Pull-down Menu
Express
Layers>
Layer Merge

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

LAYMRG

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Laymrg combines selected layers with any other layer. Objects on the layers to merge are moved to the
target layer, then the merged layer names are deleted. For example, merging layers LAYER1 and
LAYER2 to layer 0 would move the related objects to layer 0 and delete layers LAYER1 and LAYER2.
Command: laymrg
Select object on layer to merge or [Type-it/Undo]: PICK
Selected layers: Layer2
Select object on layer to merge or [Type-it/Undo] <done>: PICK
Selected layers: Layer1,Layer2
Select object on layer to merge or [Type-it/Undo] <done>: Enter
Select object on target layer or [Type-it]: PICK
******** WARNING ********
You are about to permanently merge the following layers into layer 0:
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Layer1
Layer2
Do you wish to continue? [Yes/No] <No>: y
Merging layer Layer1 into layer 0.
Merging layer Layer2 into layer 0.
All entities which were on layer Layer1 have been moved to layer 0.
All entities which were on layer Layer2 have been moved to layer 0.
Deleting layer “Layer1”.
Deleting layer “Layer2”.
2 layers deleted.
Command:

LAYDEL
Pull-down Menu
Express
Layers>
Layer Delete

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

LAYDEL

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Laydel deletes all objects on a selected layer, then deletes the layer (name). For example, selecting an
object on LAYER1 would cause Laydel to delete LAYER1 and all objects residing on that layer.
Command: laydel
Select object on layer to delete or [Type-it/Undo]: PICK
Selected layers: Layer1
Select object on layer to delete or [Type-it/Undo] <done>: Enter
******** WARNING ********
You are about to permanently delete layer Layer1 from this drawing.
Do you wish to continue? [Yes/No] <No>: y
Deleting layer “Layer1”.
1 layer deleted.
Command:

Express Text Tools Commands
Several outstanding text utilities are included in this set. For applications that insert and manipulate
text, these commands are truly a express. Some of the functions of these commands can be accomplished otherwise only by writing custom AutoLISP routines, not by using standard AutoCAD commands.
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ARCTEXT
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Text>
Arc Aligned Text

ARCTEXT

…

…

There is no other easy method to use in AutoCAD to create text along
an arc. The built-in AutoCAD commands allow creation of a line of
text only along a straight line. With this command, you can “attach”
text to an existing Arc (Fig. 47-17). You can use the same command to
edit existing ArcAlignedText objects, as noted by the prompt:

Screen (side)
Menu

…

Tablet
Menu

…

Figure 47-17

Command: arctext
Select an Arc or an ArcAlignedText: PICK (existing Arc or existing
ArcAlignedText)

After selecting an arc to use for text alignment or selecting
an existing ArcAlignedText object, AutoCAD produces the
ArcAlignedText Workshop dialog box (Fig. 47-18). Here you
can control the typical text features (style, font, height,
width factor, etc.) as well as many special features.

Figure 47-18

The following options are available in the ArcAlignedText
Workshop dialog box.
Reverse Text
This option reverses the text so it reads backwards.
Alignment
Left, Right, Fit, and Center methods can be used. If Fit is not selected, you can specify the Offset from left
and Offset from right.
Position
The text can be created on the Convex or Concave side of the arc. You can also set a value for Offset from arc.
Outward from the center/Inward to the center
This controls which direction the “top” of the letters point. Using Figure 47-17 as an example, if Inward
to the center were selected, the top of the letters would point downward resulting in upside-down text.
Typeface
Bold, Italic, and Underline can be selected.
Other Options
Other typical text options are available, such as text Height, Width factor, Style, and font file.
Existing ArcAlignedText objects can be modified with grips but keep the concentric orientation with the
aligned arc.
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TEXTFIT
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

TEXTFIT

…

…

Express
Text>
Text Fit

Screen (side)
Menu

…

Tablet
Menu

…

Textfit fits text between two specified points. Using this command gives the same results as using the Fit
option of text alignment; however, this Express command acts on existing text:
Command: textfit
Select Text to stretch or shrink: PICK
Specify endpoint or [Start point]: PICK
Command:

Using the default option you need to PICK only the new ending point and the line of text is changed
using the existing start point but specifying a new endpoint. You can also change the start point and
endpoint, as shown below:
Command: textfit
Select Text to stretch or shrink: PICK
Specify endpoint or [Start point]: s
Specify new starting point: PICK
ending point: PICK
Command:

TEXTMASK
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Text>
Text Mask

TEXTMASK

…

…

When text and other objects are drawn “on top of” each other (so
they occupy the same space), you can use Textmask to make the
text appear “in front of” other objects by “masking” the other
objects. For example, using Textmask creates text that masks other
drawing objects as shown in Figure 47-19. Use the following
command syntax:

Screen (side)
Menu

…

Figure 47-19

Command: textmask
Initializing...
Current settings: Offset factor = 0.3500, Mask type = Wipeout
Select text objects to mask or [Masktype/Offset]: PICK
1 found
Current settings: Offset factor = 0.3500, Mask type = Wipeout
Select text objects to mask or [Masktype/Offset]: Enter
Masking text with a Wipeout Wipeout created.
1 text items have been masked with a Wipeout.
Command:

Copyright 1999 The McGraw-Hill Companies. All rights reserved.

Tablet
Menu

…

Chapter Forty Seven

Batch Plot Utility and Express Tools 17

Offset factor is the distance around the text for the imaginary box that is used for “masking” (trimming)
the objects behind the text.
Select text objects to mask or [Masktype/Offset]: o
Mask offset currently set to 0.3500
Enter offset factor relative to text height <0.3500>: (value)

The Masktype option allows for three types of masking. A Wipeout obscures the background objects completely.
A 3dface mask does not mask the background objects until a Hide is performed. The Solid option allows
you to select a solid color from the standard Color dialog box to use for obscuring the background objects.
Select text objects to mask or [Masktype/Offset]: m
Mask type currently set to Wipeout
Specify entity type to use for mask [Wipeout/3dface/Solid] <Wipeout>: (option)

TEXTUNMASK
Pull-down Menu

COMMAND
(TYPE)

Express
Text>
Unmask Text

TEXTUNMASK

ALIAS
(TYPE)

Shortcut

…

Screen (side)
Menu

…

Tablet
Menu

…

…

Use Textunmask to remove the mask (wipeout, 3dface, or solid color) from text that a Textmask was previously applied to.
Command: textunmask
Select text or MText object from which mask is to be removed.
Select objects: PICK
Select objects: Enter
Removed mask from one text object.
Command:

TXTEXP
Pull-down Menu
Express
Text>
Explode Text

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Screen (side)
Menu

Tablet
Menu

TXTEXP

…

…

…

…

Textexp explodes text. The resulting objects are Plines. As
you probably know, a line or paragraph of text is one object;
therefore, without this command you cannot explode text.
Exploded text is helpful if you need to alter or manipulate
the individual text characters. For example, to convert text
into 3D solids, use Textexp, convert each letter to a Region,
then Extrude the text (Fig. 47-20):

Figure 47-20

Command: txtexp
Select text to be EXPLODED:
Select objects: PICK
Select objects: Enter
1 found.
1 text object(s) have been exploded to lines.
The line objects have been placed on layer 0.
Command:
Copyright 1999 The McGraw-Hill Companies. All rights reserved.
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RTEXT
Pull-down Menu
Express
Text>
Remote Text

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Screen (side)
Menu

Tablet
Menu

RTEXT

…

…

…

…

Rtext is a streamlined method for importing external text. The text to import can be from an external file
or can be created “on the fly” using the Diesel option. The File option produces the Select File dialog box
for you to select a .TXT file for importation. The text is drawn in AutoCAD based on the current settings
for Style, Height, and Rotation.
Command: rtext
Initializing...
Current settings: Style=Standard Height=0.5000 Rotation=0
Enter an option [Style/Height/Rotation/File/Diesel] <File>:

When the text is imported into AutoCAD, it is listed as an Rtext object and cannot be edited unless
exploded. Using Explode on Rtext converts the text to an Mtext object.

TXT2MTXT
Pull-down Menu
Express
Text>
Convert Text to Mtext

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

TXT2MTXT

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Use this Express tool to convert text (created with the Text or Dtext command) to an Mtext object.
Command: txt2mtxt
Select text objects, or [Options]<Options>:
Select objects: PICK
Select objects: Enter
1 Text objects removed, 1 MText object added.
Command:

Express Standard Tools Commands
The Standard Express toolbar contains a number of commands useful principally for modifying objects.
A few commands are included for drawing and for other utilities. If you use pull-down menus, these
commands are spread through the Modify, Draw, and Tools sections of the Express pull-down menu.
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MSTRETCH
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Screen (side)
Menu

Tablet
Menu

Express
Modify>
Multiple Entity Stretch

MSTRETCH

…

…

…

…

The typical Stretch command requires that you select objects to stretch with one Crossing Window or
Window Polygon. Any objects that are not within the selection window must be stretched with another
use of the command. In contrast, Mstretch allows you to create multiple selection windows before
stretching the objects:
Command: mstretch
Define crossing windows or crossing polygons...
Options: Crossing Polygon or Crossing first point
Specify an option [CP/C] <Crossing first point>: PICK
Specify other corner: PICK
Options: Crossing Polygon, Crossing first point or Undo
Specify an option [CP/C/Undo] <Crossing first point>: PICK
Specify other corner: PICK
Options: Crossing Polygon, Crossing first point or Undo
Specify an option [CP/C/Undo] <Crossing first point>: Enter
Done defining windows for stretch...
Specify an option [Remove objects] <Base point>: PICK
Second base point: PICK
Command:

You can use either a crossing window (C option) or a crossing polygon (CP option) to select the object(s)
to stretch.

MOCORO
Pull-down Menu
Express
Modify>
Move Copy Rotate

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

MOCORO

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Mocoro allows you to perform a Move, Copy, Rotate, or Scale, or any combination of these operations in
one command. This utility is especially useful for those who set GRIPS to 0 (off), but occasionally need
these capabilities without using Grips:
Command: mocoro
Select objects: PICK
Select objects: Enter
Base point: PICK
[Move/Copy/Rotate/Scale/Base /Undo]<eXit>: m
Second point of displacement: PICK
[Move/Copy/Rotate/Scale/Base /Undo]<eXit>: r
Second point or rotation angle: PICK
[Move/Copy/Rotate/Scale/Baset/Undo]<eXit>: c
Second point of displacement/Undo]<eXit>: PICK
Second point of displacement/Undo]<eXit>: Enter
[Move/Copy/Rotate/Scale/Base /Undo]<eXit>: Enter
Command:
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EXTRIM
Pull-down Menu
Express
Modify>
Cookie Cutter Trim

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

EXTRIM

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Extrim allows you to use an existing Circle, closed Pline, Arc, Line, Ellipse, Image, or text as a “trimming
edge.” Even though the normal Trim command allows closed Plines, this utility automates the process
by prompting only for “Side to Trim” and automatically trims all objects outside or inside the closed
boundary that cross the trimming edge object. In other words, Extrim allows you to trim like using a
“cookie cutter” when closed objects are used as trimming edges.
Command: extrim
Pick a POLYLINE, LINE, CIRCLE, ARC, ELLIPSE, IMAGE or TEXT for cutting edge..
Select objects: PICK
Command:
Pick the side to trim on: PICK
Command:

MPEDIT
Pull-down Menu
Express
Modify>
Multiple Pedit

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

MPEDIT

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Mpedit is similar to Pedit with the additional capability to select multiple Plines for editing. All selected
Plines are updated as a group. For example, you can change the Width of all Plines in a drawing globally
with this feature rather than having to change one Pline at a time:
Command: mpedit
Select objects: PICK
Select objects: PICK
Select objects: PICK
Select objects: PICK
Select objects: Enter
Convert Lines and Arcs to polylines? <Yes>: Enter
Enter an option [Open/Close/Width/Fit/Spline/Decurve/Ltype gen/eXit] <X>:

Although you may select only Plines, you will still get the “Convert Lines and Arcs to polylines? <Yes>:”
prompt. All typical Pedit options are available (note the last prompt line).
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WIPEOUT
Pull-down Menu
Express
Draw>
Wipeout

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

WIPEOUT

…

…

Wipeout creates an opaque object that is
used to “hide” other objects. The Wipeout
object is created from an existing closed
Pline. All objects behind the Wipeout
become “invisible.” For example, assume a
Pline shape was created so as to cross other
objects. You could use Wipeout to make the
shape appear to be “on top of” the other
objects (Fig. 47-21, left):

Screen (side)
Menu

…

Tablet
Menu

…

Figure 47-21

Command: wipeout
Select first point or [Frame/New from
Polyline] <New>: Enter
Select a polyline: PICK
Erase polyline? [Yes/No] <No>: Enter
Wipeout created.
Command:

You can use the “Select first point” option to create a Pline wipeout on the fly. You can create an “invisible” Wipeout by selecting the Erase Polyline option when you create the Wipeout, then use the Frame Off
option to make the Wipeout object disappear (Fig. 47-21, right). A Wipeout is an AutoCAD object. The
List command reports the object as a Wipeout object.
Use this command to draw a revision cloud on the current layer. Revision clouds are the customary
method of indicating an area of an architectural drawing that contains a revision to the original design.
Revision clouds are created on a separate layer so they can be controlled for plotting.

REVCLOUD
Pull-down Menu
Express
Draw>
Revision Cloud

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

REVCLOUD

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Revcloud is an automated routine that simplifies drawing revision clouds. All you have to do is pick a
point and move the cursor in a counter-clockwise (circular) direction and bring the cursor around to the
start point to complete the cloud (see Figure 47-22, on the next page). The cloud automatically closes
and the command ends:
Command: revcloud
Arc length = 0.5000, Arc style = Normal
Specify cloud starting point or [eXit/Options] <eXit>:
Guide crosshairs along cloud path... (move cursor in a counter-clockwise direction)
Cloud finished.
Command:
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Figure 47-23

Figure 47-22
Typing O for Options produces
the Revcloud Options dialog box
(Fig. 47-23). Here you can
select the Arc Style (Normal or
Calligraphy) and specify the Arc
Chord Length value.

PACK
Pull-down Menu
Express
Tools>
Pack’n Go…

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

PACK

…

…

Screen (side)
Menu

…

Tablet
Menu

…

The Pack command is useful for preparing drawings to be sent to clients, vendors, colleagues, etc. Pack
ensures that the drawing and all its dependencies (related files) such as Xrefs, images, and fonts are
“packed” and ready to go.
Pack produces the Pack & Go dialog box (Fig. 47-24). Here you can use the List View or Tree View options
(upper-left corner) to display the list of files. The Tree View option displays a hierarchical structure to the
parent drawing and attached Xrefs, Images, selected Fonts, etc. (see Figure 47-24).
Use the Report button in the Pack & Go dialog box to produce a written description of the dependencies
(Fig. 47-25). The report can be printed and sent as hard copy along with the files you send to your
clients.

Figure 47-24

Figure 47-25
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SUPERHATCH
Pull-down Menu

COMMAND
(TYPE)

Express
Draw>
Super Hatch…

SUPERHATCH

ALIAS
(TYPE)

…

Shortcut

Screen (side)
Menu

…

Tablet
Menu

…

The Superhatch command allows you to hatch an enclosed area, similar to the Hatch
command. However, with Superhatch you can select an image (.TIF, .TGA, .BMP,
etc.), Block, Xref, or Wipeout object to use as the hatch pattern. Using the Superhatch
command produces the SuperHatch dialog box (Fig. 47-26).

…

Figure 47-26

After you select the appropriate choice to use as a hatch pattern object (Image, Block,
Xref, or Wipeout), another dialog box appears for you to select the desired file or
object, followed by a series of prompts. For example, after selecting an image file
as the hatch pattern object, the following prompts appear:
Command: superhatch
Insertion point <0,0>: PICK
Base image size: Width: 1.000000, Height: 0.920792, Inches
Specify scale factor <1>: Enter or (value)
Command:
Is the placement of this IMAGE acceptable? [Yes/No] <Yes>: Enter
Selecting visible objects for boundary detection...Done.
Specify an option [Advanced options] <Internal point>: PICK
Specify an option [Advanced options] <Internal point>: Enter
Preparing hatch objects for display...
Done.
Use TFRAMES to toggle object frames on and off.
Command:

Typically you would prefer that the hatch object is smaller than the internal area you select for hatching.
In that case, the hatch object is replicated similar to any other hatch pattern.

TFRAMES
Pull-down Menu
…

COMMAND
(TYPE)
TFRAMES…

ALIAS
(TYPE)
…

Shortcut
…

Screen (side)
Menu

Tablet
Menu

…

Tframes is short for “toggle frames.” Type this command or use the button shown to toggle a “frame” or
outline of the hatched area (hatched with Superhatch) on or off. Keep in mind that the object(s) used to
define the hatch boundary may obscure the Superhatch frame, so when Tframes is toggled on, it may
appear as if there are two outlines.

Copyright 1999 The McGraw-Hill Companies. All rights reserved.

Chapter Forty Seven

Batch Plot Utility and Express Tools 24

SHOWURLS
Pull-down Menu
Express
Tools>
Show URLs…

COMMAND
(TYPE)

ALIAS
(TYPE)

SHOWURLS

The Showurls utility is helpful for displaying and
editing URL links (created with the Hyperlink or
Attachurl command) in the current drawing.
Showurls produces the SHOWURLS dialog box
that lists all the URLs in the drawing (Fig. 47-27).

Shortcut

…

Screen (side)
Menu

…

Tablet
Menu

…

…

Figure 47-27

You can easily locate an object with an attached
URL by selecting the Show URL button.
AutoCAD dismisses the dialog box temporarily
and highlights the drawing object, then displays
the dialog box again automatically after a second
or two.
Use the Edit option to produce the dialog box shown in Figure
47-28. Here you can edit the contents of any selected URL. Use
this option to change URLs one at a time.

Figure 47-28

Selecting the Replace option produces the Replace URL Text
dialog box where you specify a text string to Find What and
Replace What. This option globally searches and replaces specified text strings contained in URLs in the drawing. This is helpful when a series of URLs in a drawing
reference a web site that has undergone a name change.

Express Block Tools Commands
Although many of these commands were included with the AutoCAD Release 14 Bonus Tools, this set
was not grouped in one toolbar or menu, rather these commands were spread among several menus and
toolbars. In AutoCAD 2000, these commands are grouped in the Express Block Tools toolbar and in the
Blocks cascading menu (under the Express pull-down menu).

XLIST
Pull-down Menu
Express
Blocks>
List Xref/Block Entities

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

XLIST

…

…

The Xlist command displays properties of objects that are nested in Xrefs
or Blocks. This is helpful since the List command reports information
about only the top level object (Xref or Block), not information on nested
objects. Using Xlist produces the following prompt:

Screen (side)
Menu

…

Figure 47-29
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Command: xlist
Select nested xref or block object to list: PICK

After selecting an object within an Xref or Block, Xlist produces the Xref/Block Nested Object List dialog box
(Fig. 47-29). This dialog box lists properties of the selected Block or Xref.

NCOPY
Pull-down Menu
Express
Blocks>
Copy Nested Entities

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

NCOPY

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Ncopy allows you to copy objects that are nested within Xrefs or Blocks. With built-in AutoCAD commands this is possible to do for Xrefs (using Xbind), but the process is more complex than Ncopy. Ncopy
allows you to select any object within an Xref or Block to use for copying. Ncopy operates similarly to the
Copy command:
Command: ncopy
Select nested objects to copy: PICK
Select nested objects to copy: Enter
Select objects: Specify base point or displacement, or [Multiple]: PICK
Specify second point of displacement or <use first point as displacement>: Enter
Command:

BTRIM
Pull-down Menu
Express
Blocks>
Trim to Block Entities

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

BTRIM

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Btrim allows you to trim objects using nested Block or Xref objects as cutting edges. The command is
simple to use since it operates identically to the Trim command. If you select an object within a clipped
Xref, the entire object (outside the clipping boundary) is highlighted.
Command: btrim
Select cutting edges: PICK
Select cutting edges: Enter
Select objects:
Select object to trim or [Project/Edge/Undo]: PICK
Select object to trim or [Project/Edge/Undo]: Enter
Command:

Btrim has the same options as Trim (see PROJECTMODE and EDGEMODE, Chapter 9).
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BEXTEND
Pull-down Menu
Express
Blocks>
Extend to Block Entities

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Screen (side)
Menu

Tablet
Menu

BEXTEND

…

…

…

…

Bextend allows you to extend objects using nested Block or Xref objects as boundary edges. This utility
(like the Btrim utility) is similar to the built-in AutoCAD counterpart but with the added capability of
extending objects to Block and Xref objects. Bextend operates identically to the Extend command:
Command: bextend
Select edges for extend: PICK
Select edges for extend: Enter
Select objects:
Select object to extend or [Project/Edge/Undo]: PICK
Select object to extend or [Project/Edge/Undo]: Enter
Command:

GAT TE
Pull-down Menu
Express
Blocks>
Global Attribute Edit

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

GATTE

…

…

Gatte makes global changes to attribute
values. Gatte allows you to make changes to
all insertions of the same Block in a drawing
with one operation. For example, assume
you wanted to change the PART_NO attribute
for all insertions of the CAP (capacitor) block
in the schematic shown in Figure 47-30. Use
Gatte and follow the command prompt below
to change all PART_NO attribute values to
“C-47XXX:”

Screen (side)
Menu

…

Figure 47-30

Command: gatte
Select block or attribute [Block name]: PICK
Block: CAP Attribute tag: CAPACITOR_NO
Enter new text: c-47xxx
Number of inserts in drawing = 3 Process
all of them? [Yes/No] <Yes>: Enter
Please wait...
3 attributes changed.
Command:

The attribute values for all insertions of the Block are updated (three Blocks on left, Figure 47-30).
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BURST
Pull-down Menu
Express
Blocks>
Explode Attributes to text

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

BURST

…

…

Screen (side)
Menu

Tablet
Menu

…

…

Use Burst with attributed text (text combined with a Block) like you would use Explode with an
unattributed Block. Burst actually explodes text attributes but converts the attributes to Text objects.
Normally, if you select attributes to Explode, the Block is exploded and the text is changed back to text,
indicating the original attribute definitions—that is, tags, values, and prompts. (See Chapter 22, Block
Attributes.) Using Burst may cause the newly created Text objects to be misaligned from their previous
orientation.
Command: burst
Select objects: PICK
Select objects: Enter
Command:

CLIPIT
Pull-down Menu
Express
Blocks>
Extended Clip

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

CLIPIT

…

…

Screen (side)
Menu

Tablet
Menu

…

…

AutoCAD has the unique feature of clipping Xrefed drawings by specifying a polygonal or rectangular
Pline (no arc segments) as the clipping boundary. Clipit extends that capability by allowing you to use an
existing Circle, Arc, Pline, Ellipse, or text as a clipping edge for an Xref, Block, or Wipeout (see Wipeout):
Command: clipit
Pick a POLYLINE, CIRCLE, ARC, ELLIPSE, or TEXT object for clipping edge...
Select objects: PICK
Command:
Pick an IMAGE, a WIPEOUT, or an XREF/BLOCK to clip...
Select objects: PICK
Command:
Enter maximum allowable error distance for resolution of arc segments <0.0200>: Enter or (value)
Command:
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Additional Express Tools Commands
Commands in this section are included in the Express pull-down menus (under Dimension, Selection Tools,
Modify, or Tools), but are not included in any of the Express toolbars.

QLATTACH
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Dimension>
Leader Tools>
Attach Leader to…

QLATTACH

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Use Qlattach to attach an existing leader to an annotation (Mtext, Block, or Tolerance objects). Qleader automatically changes the endpoint of the leader and/or moves the annotation to align and attach to the top
of the top line of text. If the annotation object is later moved, the leader stays attached.
Command: qlattach
Select Leader: PICK
Select Annotation: PICK
Command:

QLDETACHSET
Pull-down Menu

COMMAND
(TYPE)

Express Tools
Dimension>
Leader Tools>
Detach Leaders
from Annotation

QLDETACHSET

ALIAS
(TYPE)

…

Shortcut

…

Screen (side)
Menu

Tablet
Menu

…

…

The Qldetachset command can be used to “break” the connection between a leader and the related text.
When Qldetachset is used, the leader and related text become independent objects and can be modified
separately. In addition, the leader line no longer contains a “hook” (short horizontal segment) aligned
with the text object. Qldetachset operates for text/leader combinations created with the Leader, Qleader, or
Qlattach commands.

QLATTACHSET
Pull-down Menu

COMMAND
(TYPE)

Express Tools
Dimension>
Leader Tools>
Global Attach Leader
to Annotation
QLATTACHSET

ALIAS
(TYPE)

…

Shortcut

…

Screen (side)
Menu

Tablet
Menu

…

This command is intended to attach previously created leaders to existing Mtext, Tolerance, or Block
objects. Qldetachset is similar to the Qlattach command, with the exception that multiple annotation or
leader objects can be selected in response to the “Select objects:” prompt.
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DIMEX
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Dimension>
Dimstyle Export…

DIMEX

…

…

This is a very useful utility for exporting dimension styles from the current
drawing to a file for importation into another drawing with Dimim
(dimension import). Dimex produces the Dimension Style Export dialog box
(Fig. 47-31). Select a dimension style to export, then select OK. The
dimension style is saved to a file with a .DIM file extension.

DIMIM
Pull-down Menu
Express
Dimension>
Dimstyle Import…

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

DIMIM

…

…

Use Dimim to import previously exported dimension styles (see Dimex).
Dimim invokes the Dimension Style Import dialog box (Fig. 47-32). Use
Browse… to locate the desired *.DIM file.

GETSEL
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Selection Tools>
Get Selection Set

GETSEL

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Figure 47-31

Screen (side)
Menu

…

Tablet
Menu

…

Figure 47-32

Screen (side)
Menu

…

Tablet
Menu

…

Getsel allows you to PICK specific objects by object type or by layer and use them as the current selection
set. You can select the desired layer (or all layers) or the desired object type (or all object types). This
utility is a fast alternative to using the Filter command to locate and find specific object types. Getsel
issues the following prompt:
Command: getsel
Select an object on the Source layer <*>: PICK
Select an object of the Type you want <*>: PICK
Collecting all LWPOLYLINE objects on layer GEOMETRY...
7 objects have been placed in the active selection set.
Command:
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EXF
Pull-down Menu
Express
Selection tools>
Exclude Fence

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

EXF

…

…

Screen (side)
Menu

…

Tablet
Menu

…

The EXF command allows you to use the Fence selection method to pick objects that are not to be
included in the desired selection set. All other items (not selected with the Fence) automatically become
highlighted as the selection set. EXF can be used before issuing a command, but it is also transparent so
it can be used during another command. (Normally, if you wanted to select objects before issuing a
command, only the pickbox, window, and crossing window options would be available.)

EXP
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Selection tools>
Exclude Previous

EXP

…

…

Screen (side)
Menu

…

Tablet
Menu

…

The EXP command automatically selects all objects on Thawed and Unlocked layers except the previous
selection set. As with the Previous option, no actual selection is required on your part. EXP can be used
before issuing a command, but it is also transparent.

EXW
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Selection tools>
Exclude Window

EXW

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Use the EXW command to create a selection window around the objects you want to exclude from the
selection set. All other items (not selected with the EXW window) automatically become highlighted as
the selection set. As with the other Express Selection Tools, EXW is transparent.

EXCW
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Selection tools>
Exclude Crossing
Window

EXCW

…

…

Screen (side)
Menu

…

Tablet
Menu

…

EXCW is similar to EXW, except a crossing window is used to pick objects that are not to be included in
the desired selection set. All other items (not selected with the crossing window) automatically become
highlighted as the selection set. EXCW can be used before issuing a command, but it is also transparent
so it can be used during another command.
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EXWP
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Selection tools>
Exclude Window
Polygon

EXWP

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Use the EXWP command to create a window polygon around the objects you want to exclude from the
selection set. All other items (not selected with the window polygon) automatically become highlighted
as the selection set. In some cases, A Window Polygon is preferred over a Window because the polygon
can have any number of sides and any orientation, whereas a Window can only be rectangular. EXWP
can be used before or during another command, similar to the other Express Selection Tools.

EXCP
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Selection tools>
Exclude Crossing
Polygon

EXCP

…

…

Screen (side)
Menu

…

Tablet
Menu

…

This command allows you to select objects to exclude from the selection set using the Crossing Polygon
selection method. The EXCP crossing polygon is similar to the EXWP window polygon, except in this
case all objects within and crossing the polygon become excluded from the selection set. All other items
(not selected with the crossing polygon) automatically become highlighted as the selection set. EXCP is a
transparent command.

PLJOIN
Pull-down Menu
Express
Modify>
Polyline Join

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

PLJOIN

…

…

Screen (side)
Menu

…

Tablet
Menu

…

You can use Pljoin to join two or more polylines when the line endpoints do not meet exactly. Pljoin
prompts you for a selection set (of polylines) and a fuzz distance.
Command: plinejoin
Select objects: PICK
Select objects: Enter
Join Type = Both (Fillet and Add)
Enter fuzz distance or [Jointype] <0.0000>: (value)
Processing pline data... Done.
Command:

At the “fuzz distance” prompt, enter a value large enough to fill the gap between the selected Plines.
The Jointype option allows you to specify if you want to connect the Plines by either inserting a new
segment (Add) or by trimming or extending the two segments to their common or extended intersection
point, similar to filleting with a radius of 0 (Fillet). You can instead use the PLJOINMODE variable to set
the Jointype.
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FULLSCREEN
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Tools>
Full Screen AutoCAD

FULLSCREEN

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Fullscreen re-sizes the AutoCAD window to fill the maximum amount of screen area by hiding the
Windows title bar and the AutoCAD pull-down menu bar. Fullscreen also hides the Status bar. In full
screen mode, you can click at the top of the window to make the pull-down menu bar appear but you
cannot make the Status bar appear. Use Fullscreen again to return the AutoCAD display to the previous
setting (normal screen mode).

MKLTYPE
Pull-down Menu
Express
Tools>
Make Linetype

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

MKLTYPE

…

…

Screen (side)
Menu

…

Tablet
Menu

…

This new linetype maker allows you to create linetypes in two ways. First, you can create linetypes from
an existing pattern of lines and polylines and easily turn them into a linetype without going through the
typical linetype definition steps. For example, assume you have a series of line segments that you wish
to use as your linetype “template.” Use the Mkltype command, follow the prompts shown below to
select the existing line segments, and AutoCAD automatically creates and loads the new linetype.
Command: mkltype
(The Select File dialog box appears. Enter the desired name for an .LIN file to store the new linetype.)
Enter linetype name: longdashes
Enter linetype description: Enter
Specify starting point for line definition: PICK (first point to define segment length)
Specify ending point for line definition: PICK (second point)
Select objects: PICK
Select objects: PICK
Select objects: PICK
Select objects: Enter
Linetype “LONGDASHES” created and loaded.
Command:

Secondly, you can use Mkltype to define the linetype using the typical linetype definition method. You can
even include shape or text objects to create a complex linetype, as shown in the following series of prompts.
Command: mkltype
Enter linetype name: fence
Enter linetype description: a,1.5,-0.25,[“x”,standard,s=0.2,r=0.0,x=0.05,y=-0.1],
-0.4,1.5
Specify starting point for line definition: PICK (first point to define segment length)
Specify ending point for line definition: PICK (second point)
Select objects: PICK (to define object type)
Select objects: Enter
Linetype “FENCE” created and loaded.
Command:

Refer to Chapter 44, “Creating Custom Linetypes,” for information on linetype definitions.
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MKSHAPE
Pull-down Menu
Express
Tools>
Make Shape

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

MKSHAPE

…

…

Screen (side)
Menu

Tablet
Menu

Use this new command to create shape files “on the fly” without having to go through the typical steps
of shape definition. First, create some geometry composed of AutoCAD objects to use as the “template”
shape. Next, use the Mkshape command and follow the prompts shown below to create the new shape
file.
Command: mkshape
(The Select File dialog box appears. Enter the desired name for an .SHX file to store the new shape.)
Enter the name of the shape: square
Enter resolution <128>: Enter or (value)
Specify insertion base point: PICK
Select objects: PICK
Select objects: PICK
Select objects: PICK
Select objects: PICK
Select objects: Enter
Determining geometry extents...Done.
Building coord lists...Done.
Formating coords...|Done.
Writing new shape...Done.
Compiling shape/font description file
Compilation successful. Output file D:\A 2000 Instructor\Dwg\Ch47\newshapes.shx
contains 135 bytes.
Shape “SQUARE” created.
Use the SHAPE command to place shapes in your drawing.
Command:

REDIR
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Tools>
Path Substitution

REDIR

…

…

Screen (side)
Menu

Tablet
Menu

The new Redir command allows you to substitute any or all hard coded path names for Xrefs, styles,
shapes and images. Redir operates like a search and replace, so you can specify a new path, substitute a
portion of a path, or even remove path references entirely. Use the “?” option to list the current paths.
Command: redir
Current REDIRMODE: Styles,Xrefs,Images,Rtext
Find and replace directory names
Enter old directory (use ‘*’ for all), or ? <options>: ?
Enter file references to list <*>: Enter
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Current REDIRMODE: Styles,Xrefs,Images,Rtext
TYPE
NAME
FILE
———————————————————————————
STYLE
STANDARD
TXT
STYLE
30-FLOR|STANDARD
TXT
STYLE
30-FLOR|ROMANS
ROMANS
STYLE
30-FLOR|COMPLEX
COMPLEX
STYLE
30-FLOR|SIMPLEX
SIMPLEX
STYLE
30-FACIL|STANDARD
TXT
STYLE
30-FACIL|ROMANS
ROMANS
STYLE
30-FACIL|COMPLEX
COMPLEX
STYLE
30-FACIL|SIMPLEX
SIMPLEX
XREF
XREF

30-FACIL
30-FLOR

D:\Dwg\30-facil.dwg
D:\Dwg\30-flor.dwg

Enter old directory (use ‘*’ for all), or ? <options>:

To use Redir to substitute a new path, follow the example prompt below.
Command: redir
Current REDIRMODE: Styles,Xrefs,Images,Rtext
Find and replace directory names
Enter old directory (use ‘*’ for all), or ? <options>: D:\Dwg
Replace “D:\DWG” with: Q:\Dwg\Xrefs
Searching for old dir: D:\DWG
in order to replace it with: Q:\DWG\XREFS
XREF
30-FLOR
D:\Dwg\30-flor.dwg -> Q:\DWG\XREFS\30-FLOR.DWG
XREF
30-FACIL
D:\Dwg\30-facil.dwg -> Q:\DWG\XREFS\30-FACIL.DWG
0 style/shape records modified.
0 image references modified.
2 xrefs modified.
0 rtext objects modified.
Changes to some externally referenced objects may be temporary.
Command:

Enter the Ridmode command or use the Options in the Redir command to
produce the REDIRMODE dialog box (Fig. 47-33). Here you select which
objects you want to be affected by the Redir search and replace you
specify.

Figure 47-33
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XDATA
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Express
Tools>
Xdata Attachment

XDATA

…

…

Screen (side)
Menu

…

Tablet
Menu

…

Extended entity data is additional information that can be attached to any AutoCAD object. Extended
entity data provides an internal level of information “attached” to each individual object. This
AutoCAD feature is extremely powerful for customization applications.
Xdata is an Express utility to simplify attaching extended entity data to an object. Use Xdata to produce
the following prompt:
Command: Xdata
Select object: PICK
Enter application name: (name)
(NAME) new application.
3Real/DIR/DISP/DIST/Hand/Int/LAyer/LOng/Pos/Real/SCale/STr/<eXit>: (option)
New xdata appended.
Command:

The prompt displays the areas of information that can be attached to an object: 3 Real numbers, 3D world
space direction, 3D world space displacement, Distance, Database handle, 16-bit integer, Layer, 32-bit long integer,
3D world space position, Real number, Scale factor, and ASCII string.

XDLIST
Pull-down Menu

COMMAND
(TYPE)

ALIAS
(TYPE)

Shortcut

Screen (side)
Menu

Tablet
Menu

Express
Tools>
List Entity Xdata

XDLIST

…

…

…

…

Xdlist lists extended entity data attached to a nested object. An example is listed below:
Command: xdlist
Select object: PICK
Enter application name <*>: (name)
* Registered Application Name: (NAME)
* Code 1002, Starting or ending brace: {
* Code 1000, ASCII string:
* Code 1003, Layer name: 0
* Code 1042, Scale factor: 0.5000
* Code 1000, ASCII string: sample object
* Code 1002, Starting or ending brace: }
Object has 16347 bytes of Xdata space available.
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Additional Express Tools Commands, Command Line Entry Only
Commands in this section are not included in the Express toolbars or Express pull-down menus. All of
these commands must be typed.

BLOCK?
This utility lists coordinate and other information about objects composing a Block definition as shown in
the following example:
Command: block?
Block name/<Return to select>: PICK
Enter an entity type/<Return for all>: Enter
Press ESC to exit or any key to continue.
((0 . "BLOCK") (2 . "TBLOCK2") (70 . 2) (10 0.0 0.0 0.0) (-2 . <Entity name:
2b90668>))
((-1 . <Entity name: 2b90668>) (0 . "LWPOLYLINE") (5 . "65") (100 .
"AcDbEntity") (67 . 0) (8 . "0") (100 . "AcDbPolyline") (90 . 4) (70 . 0) (43 .
0.02) (38 . 0.0) (39 . 0.0) (10 -4.0 0.0) (40 . 0.02) (41 . 0.02) (42 . 0.0)
(10 -4.0 0.0) (40 . 0.02) (41 . 0.02) (42 . 0.0) (10 -4.0 1.625) (40 . 0.02)
(41 . 0.02) (42 . 0.0) (10 0.0 1.625) (40 . 0.02) (41 . 0.02) (42 . 0.0) (210
0.0 0.0 1.0))
((-1 . <Entity name: 2b90698>) (0 . "LINE") (5 . "6B") (100 . "AcDbEntity") (67
. 0) (8 . "0") (100 . "AcDbLine") (10 -4.0 0.375 0.0) (11 0.0 0.375 0.0) (210
0.0 0.0 1.0))

BCOUNT
The Bcount Express command counts and lists the number of Block insertions in each drawing or selection set. You can count all Blocks in a drawing or specify a selection window. The following example is
the Bcount results for the example schematic drawing used in Chapter 22:
Command: count
Press enter to select all or…
Select objects: Enter
Counting block insertions…Block Count
---------CAP ...... 3
RES ...... 3
Command:

SSX
SSX is a powerful utility that allows you to find objects of similar type (Circle, Arc, Line, etc.) for the
selection set by selecting only one object. You can also specify a certain criteria. This feature is simpler
than using Filter but can be almost as powerful. Enter SSX at the command prompt to initialize the
routine, then enter “(SSX)” at any “Select objects:” prompt to use it. For example, you can select all
similar objects (“Flatfile” block in this case) by selecting only one:
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Command: move
Select objects: (ssx)
Select object/<None>: PICK
Filter: ((0 . "INSERT") (2 . "FLATFILE") (8 . "FURNITURE") (210 0.0 0.0 1.0))
>>Block name/Color/Entity/Flag/LAyer/LType/Pick/Style/Thickness/Vector: Enter
10 found. 10 found
Select objects: Enter
Base point or displacement: PICK
Second point of displacement: PICK
Command:

EXPRESSTOOLS
You can use the Expresstools command to make the AutoCAD Express Tools available in the current profile
if they are not yet available. Expresstools places the Express directory on the search path, and loads and
places the Express menu on the pull-down menu bar. The Express Tools must first be installed for this
command to operate (see “Installing the Express Tools from the CD-ROM” earlier this chapter).
Once the Expresstools command is used, the Express Tools libraries load when AutoCAD is started. This
increases the load time for AutoCAD but reduces the delay when you use one of the tools for the first
time.

EXPRESSMENU
Expressmenu loads the AutoCAD Express pull-down menu specifically. If the Express Tool commands are
available on the command line but the Express pull-down menu is not displayed, use the Expressmenu
command to display the menu.
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